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Introduction
This handout covers some of the new and cool features available in DDMS
software. All of the features described in this handout are included in the
DDMS online help. Some of these features also have complete handouts. All of
the handouts are available on our web site at www.ddms.com/support/doc/
ver8doc.htm

In talking with customers using text-based versions of the DDMS software
about our graphical product, we’ve heard some interesting things. It seems
there are a lot of misconceptions about the software and its capabilities. We’d
like to set the record straight and offer some good reasons why, if you aren’t
already using the graphical software, you should be.

This handout covers the benefits of graphical as well as cool features available
throughout the system.

Text AND Graphical
The choice of text or graphical has as much to do with personal preference as
actual software performance. That’s why the graphical software gives you
both. Almost every graphical application gives you the option of using the text
screens if you prefer while still having the convenience and ease-of-use offered
by the Windows® environment. Why go graphical? There are definite advan-
tages to graphical, and we believe the increased efficiency more than offsets
the transition costs over the long term. Here are a few of them.

Legibility
With the graphical software, data is contained in defined boxes. It’s easier and
faster to find and read information.

Training
The graphical software reduces training time. You can get new employees up
and running much more quickly in the Windows environment.

Online Help
Did you know that DDMS has comprehensive online help? Help is always at
your fingertips. The Help file contains three tabs: Contents, Index, and Search.
You can use the Contents tab to quickly drill down to the subject for which to
view information. You can click the Index tab to quickly and easily look up a
box by name. Each and every box in the DDMS system is indexed individu-
ally. For example, if you need more information about the Hold Type box in
the Customer Order Entry tab, you simply type Hold Type and the indexed in-
formation comes right up. Double-click the index entry and the indexed topics
can be viewed.
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Use the Search tab to quickly search for a term when you are not sure of where
to look for it. Searching is as easy as typing a generic term like order entry. Ev-
ery topic that has the words order and entry are returned in your search. For a
more specific search, type order entry in quotes: “order entry”. Then only top-
ics that have that exact phrase are returned in your search.

Another way that allows you to quickly view information is to use F1. Click
the Help button at the top of each window or press F1 at any time. Pressing F1
also brings up help specific to where your cursor is on the window. (This is
context-sensitive help, shown in Figure 1.) Using our earlier example, you
might click the Hold Type box in the Customer Order Entry tab then press F1.
The help topic for the Hold Type box immediately displays. For more informa-
tion on navigating DDMS, read the online help topics called Introduction to
DDMS.

Using Keyboard or Mouse, It’s Your Choice
Many users told us they didn’t want to use a mouse to move around the win-
dow; a keyboard is faster, they said. Again, this is a matter of preference. For
an experienced user, a keyboard can be faster. That’s why our graphical win-
dows support keyboard shortcuts for navigation and most system functions.
For example, you can complete an entire order in order entry without ever us-
ing the mouse! However, if you prefer to use the mouse, it’s your choice. You
can use your mouse to move around in any of the windows.

Figure 1:
Context

Sensitive Help
for the Status

OE Box
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Shortcut and Access Keys
Shortcut keys are either function keys, like F9, or a combination of the Control
key and a letter, such as Ctrl + R. For example, to view outstanding items on a
purchase order, type Ctrl + O.

Access keys are keys corresponding to the underlined letter in a menu or tab
name. To open a menu or move to a tab, hold down the Alt key and press the
access key. For example, to open the P/O Browse dialog box, type Alt + B.

You can select multiple line items in many applications just like you do in
other Windows programs. To select several different lines, press the Ctrl key
and click individual lines. You can also select several lines in a row by clicking
the first line, holding the Shift key and clicking the last line.

One User—Multiple Sessions
The graphical software allows you to work in multiple applications at the
same time. You can review a customer’s A/R history in one window while en-
tering a new order in another, for example. While our text-based software for
the Microsoft® Windows and UNIX platforms allow this type of multi-task-
ing, each open program (session) requires one user license. With graphical,
you only need one license per user, regardless of the number of applications.

Cutting and Pasting
The Windows environment lets you cut, copy and paste data from one box to
another. This saves time in creating records. For example, when creating a cus-
tomer ship-to record, you can copy relevant information like city or state from
the billing record instead of re-keying it.

Smart Windows
When using multiple applications, changes in one window can affect related
information displayed in another. For example, suppose you open a
customer’s master record in one window and the account history in another.
Change to a different customer record, and the history window automatically
displays the new customer’s account.

User Preferences
Each graphical user can set his/her own preferences. If you have a furniture
operation and an office products operation, your order entry personnel can
view furniture order entry information or hide it from view.

You can add and remove buttons from the toolbars in the databases and appli-
cations.

You can also customize grids in almost every database or application. For ex-
ample, in A/R History in the A/R Detail tab, click the Set Grid Options but-
ton. You customize your grid by simply clicking the options to set.
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Look-ups
Many of your operators probably have keystrokes and other information
memorized. But imagine the ease of looking up a salesperson’s number or a
tax district,  without having to remember it or look it up on a list that may or
may not be handy.

You can look up information using almost any box in the system. You can
view history data and other detailed data from all the databases at the same
time. You can re-sort information as needed. Just click on the button by which
you want to sort.

Drill-down menus are available throughout the system. For example, in order
entry, you select the action from a drill-down menu.

Searching/Sorting Using a Search Box
Most windows have search boxes. Any box that is bold can be used for search-
ing. Tab to or click the box by which to search or sort. This highlights the infor-
mation currently in the box.

Type the information over the highlighted information. (This does not destroy
the current information.)

Press Enter to find the first instance of the information you typed or sort the
information beginning with the information you typed. When searching, if the
first instance is not correct, scroll until the requested information appears, or
search again using a different search box.

Scrollable Data Windows
Scrollable data windows means fewer errors and less to memorize.

You can scroll forwards and backwards and use the up and down arrow key to
easily navigate through information.

Pop-up Windows
Pop-up windows display available choices for things like salesperson num-
bers, customer information, item information, and almost any other type of
data.

Ease-of-Use
Ease-of-use was a major factor in developing the graphical software. It offers a
simpler, more consistent interface. The Order Entry window is a perfect ex-
ample. Changing a setting in the Global tab always affects the entire order,
while changes in the Item Detail tab affect only the selected line item.
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Database Management
Creating and maintaining database records — customers, vendors, inventory,
etc. — is simply faster and easier in the graphical software. There’s no more
switching screens and tabbing through fields. Just click the box to change, en-
ter the data, and click  Save.

New Technology
ECi recently introduced a new generation of business system technology.
These applications incorporate smart-client architecture, SQL databases, the
Microsoft® .NET programming framework, and a completely redesigned user
interface. These changes provide very real benefits to you:

• Improved performance and reliability

• Ability to accomodate future growth

• Simpler customization

• Better security.

Ensite EBS (Enterprise Business System) is Windows-based with new GUI
(graphical user interface) and .NET platform. Programming is done in
Microsoft Visual C#. Ensite EBS allows us to completely detach from TBL —
all business logic will be rewritten. Utilizing this new technology makes one
major difference: standard coding practices. This makes the system easier to
enhance and maintain.

Cross Reference of Text-Based Screens to
Windows
You may find that older documentation refers to text-based screens, such as
the (E) screen, for example, which performs the same function as its graphical
counterpart, the Item window. Or, you may find that you’re referenced to the
(AT) Tax Districts Tables screen,which in graphical software is located in the
View menu of the Customer window. The reference list at the end of this
document is designed to help you find the right graphical software window
when all you have is a set of keystrokes for a text-based screen name. For each
text-based screen name, we list the screen title, and the directions to the
equivalent graphical software window. While there may be more than one
way to get to a screen, this table details the most common method.

What’s an Icon?
In graphical user interfaces, an icon is a small picture with a label. In these in-
structions, an icon is in the master menu or application menus of your DDMS
software.



8

Why Not Graphical?

When you double-click an icon, it launches a program. For instance, when you
are in the DDMS Master Menu, and double-click the Reports Menu icon, the
Reports Menu appears. (See Figure 2.) When you then click the Standard Cus-
tomer Reports icon, a new window opens with a selection of standard cus-
tomer reports.

What’s a Tab?
A tab may be a keystroke to take you to the next data field. However, in these
instructions, a tab is a clickable region of the window that contains data fields
or reports. It’s a way to conserve space within an application, or to indicate the
next stage in a task. For example, in Order Entry, there are tabs for Global,
Item Detail, and Order Totals, in the exact sequence you must follow to com-
plete an order.

Where is View?
Menu bars are found along the top of DDMS windows, between the title bar
and the toolbar row of buttons. When you click the menu name, a list of op-
tions opens. Click the option you want and the appropriate action takes place.

View is the title of one of these menus. For example, when you are in the Item
database, and click View on the menu bar, then select Item Bins, the Multiple
Bins window appears.

File and Action are other examples of menu titles.

Figure 2:  The
Reports Menu

Icon



9

Why Not Graphical?

Accounts Receivable
The Accounts Receivable (A/R) application lets you monitor and update your
customers accounts. Each accounts receivable account represents the amount
owed by a customer for purchases (orders) or services. Through the Accounts
Receivable application, you can build and maintain a complete and accurate
history for all your customer's accounts receivable activity.

Disputed Invoices
A new feature lets you mark invoices that have been disputed. This allows
your A/R clerk to be aware of any invoices that are being disputed before ever
making a collection call.

Pay by Groups
If you have a customer that pays multiple accounts with one check, this fea-
ture is what you need. You can assign customers a group code in the Customer
database then use that group code to retrieve the customers in the Accounts
Receivable Payments Tab. If you retrieve using this method, you can post pay-
ments to customers with a specific group code.

As with paying multiple accounts with one check, as long as you check the
Update Customer History box, each customer’s account is updated with the
payment date, amount, and check number.

Quick Pay Posting
Quick pay posting is the DDMS equivalent of the text-based Multiple Ac-
counts Per Check method in the (BQ) Accounts Receivable Check Posting
screen. You can apply a payment to multiple accounts at once, applying a par-
ticular check amount to more than one account.

When you post payments, Quick Pay posts the check number, date, and last
payment information to all accounts. The program also updates the 90 $, 60 $,
and 30 $ boxes in the Customer Credit tab for every account for which you
paid invoices. In addition, the Check # field in the C-AUX file is updated for
all posted accounts.

A/R Query
The A/R History Invoice Query dialog box lets you locate and select an in-
voice from a list of invoices. You can search by the following: invoice number,
purchase order number, check number, date, payments, and charges.

In the A/R History Detail Tab, you can use the Long PO # box to select the in-
voice to view. Enter the long purchase order number in the Long PO # box,
and press Enter. You can enter up to 30 characters in this box. The invoice that
most closely matches the one you specified appears.
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You can also use the Long PO # box to retrieve variations of long purchase or-
der numbers. To do so, combine part of the purchase order number with an
asterisk (*). The asterisk serves as a wildcard; it represents any character. (The
wildcard feature works with short P/O numbers, as well.) Suppose you enter
*123 as the purchase order number. The system would display all P/Os end-
ing in 123 — 4123, 56123, a123. Or suppose you specify 123*. The system
would include all purchase orders numbers beginning with 123 — 123456,
1239, 123a. Likewise, if you specify *123*, the numbers could appear any-
where in the sequence — 123456, 4123, 51234, a123, and so forth. The system
searches for the purchase order in the journal set in the Journal box, JNL-AR,
for example.

Printing Statements in A/R History
In A/R History, printing a statement is easier than ever! To print a statement
in the A/R History window, select the customer, then click the drop down ar-
row next to the Print button to select Print Statement. And even better, no
more finance charges! In text-based software, you might accidentally add on
finance charges to a statement. In graphical, this is no longer an issue!

Accounts Payable
Since you can mark and unmark invoices for payment, accounts payable
postings are easier than ever before. Previously, you ran the To-Be-Paid Report
and reviewed it before applying changes. Now changes are made before the
checks are released.

In the Accounts Payable Posting window, you can set limits for the vendors
whose invoices you need to pay. When you do, you can append and update
the AP-PAY file directly through the A/P window. You can even delete it, if
necessary.

Through the AP Payment Limits dialog box, you can limit by vendor account
number, name, code, location, and date. After the invoices are displayed, you
simply click the invoices to pay. You can also click Recap by Vendor to verify
the invoices you’ve marked.

Paying invoices by hand-written check is also much easier. You simply click
the Hand Check button and enter the vendor information, including the check
number. Then mark the invoices to pay. Postings are not made to accounts
payable until you are ready. If you change your mind, you can cancel the
transaction without posting anything.

Posting purchase orders has been made easier then ever by the addition of the
A/P Post P/O tab. You can use this tab to see every line item that has been
purchased but not posted against. You can also change the purchase order and
the invoice cost without leaving the A/P window.
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While in the A/P window, you can also view additional vendor information,
purchase order entry history, and accounts payable history. Once you access
the P/O History window, you can view order entry history.

Viewing A/P History
The Accounts Payable window lets you easily view A/P history information.
You can see at a glance the vendor’s invoices; payments and charges; invoice,
voucher, and net dates; check numbers; purchase order numbers; and much
more. Since the information is shown in columns, you can click the column
heading to re-sort the data, allowing you to easily find the information you
need. For example, if you click the Invoice # column, you can sort the dis-
played invoices by invoice number, from highest to lowest. Likewise, by click-
ing the Charges column, you can sort the data by charge amount. You can also
exclude zero balance invoices with a single click.

From A/P history, you can enter a check number to see what purchase orders
were paid or vice versa; you can enter the purchase order number to see what
check was used to pay the P/O.

You can also access Purchase Order Entry History to view P/O information.
To do so, click the View menu and select P/O History.

Order Entry
Order entry allows you to find information without ever leaving the applica-
tion. You can make changes while online. You can quickly scan back and forth
during an order by simply clicking the tabs. When entering an order, you can
easily change the salesperson or even the customer. Even if you’ve entered
several items on an order, you can still make global or line item changes, such
as changing the tax, for the entire order or for a line that has been previously
entered.

When you retrieve a customer in order entry, settings for that customer dis-
play at the top of the window. In the example shown in Figure 3, this customer
is set up for summary billing. You can access item detail or order totals at any
time while placing an order.

You can quickly look up customer item history without ever leaving your or-
der; just right-click on an item and view history for this customer.

You can enter order notes and change order settings by simply pressing a
function key. Also, when changing or verifying items on an order, you can re-
sort the information as needed. You can sort by item description or company
name, for example.

You can release a quote in one easy step. You have the ability to view all or-
ders or quotes without having to know which number to query.
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There are several ways you can move through the order entry boxes. Pressing
Enter, Tab, or using your mouse moves you through the order entry windows
and dialog boxes. Function keys and access keys are also available. For ex-
ample, in the Order Entry Global tab, type Alt + M to move the cursor directly
to the Dept Name box.

There are several ways to access O/E History. You can view customer order
history without ever leaving order entry by pressing F5. You can view order
entry history by clicking the button at the top of the order entry tab or by us-
ing access keys.

Change, Verify, Delete Orders
In the Order Entry window, you can change, verify, and delete orders.

You can click the Order Browse button to access all tickets that are available to
be verified, changed, or deleted. Or you can perform a query. Press the F11
key to display the Order Notes dialog box as you browse through the tickets.

Order Changes
Our graphical software lets you easily change almost any component of an or-
der, including things that are impossible in text-based. Suppose you are ready
to end the order and realize you retrieved the wrong departmental account.

Figure 3:
Customer

Settings
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With graphical, you simply retrieve the correct department record, then con-
tinue with the order. You can change line items by double-clicking or by high-
lighting the item and pressing Enter. You can also scroll up or down by click-
ing the up or down arrow keys to access a line. Once the item is highlighted,
press Enter to change the item.

The Change tab is used for quick changes. This means changes you commonly
make such as changing the shipped quantity; the item's selling price, list price,
and cost; changing the gross profit percentage of an item; or the purchase or-
der number.

In addition to making these quick changes, you also have the ability to change
all of the information for an individual line item or you can change an entire
order.

You can also add an item or substitute one item for another. Adding an item is
similar to placing an item on the original pick ticket. When you substitute one
item for another, the application checks stock levels for the new item and
places information such as the item's stock class, inventory department, unit of
measure, and cost on the pick ticket.

Order Settings Dialog Box
This dialog box is easy to use and easy to understand. Simply press F6 and the
Order Settings dialog box opens. In this dialog box, you can enter discount
types, who called, price breaks, price plans, and much more.

Order Notes Dialog Box/Entering Specials
Order entry specials have never been easier. With the graphical software, all
you have to do is press the F11 key to display the Order Notes dialog box.
Separate boxes let you enter text for beginning, ending, and line item specials.
No more special commands to remember and type. You can even select
whether the special text displays on the ticket, short-buy, backorder, or pur-
chase order.

Ship-to Lookup
Looking up multiple shipto addresses and attentions is easier than ever. In or-
der entry, select the query button to display the complete list of shipto ad-
dresses. For a list of attentions for this customer, press Ctrl + A.

Searching in Order Entry
You can also select customers using the word search feature. You do this using
two \\ (back slashes) and specific text. For example, to retrieve all customer
accounts containing the word office, click the Name box and type \\OFFICE.



14

Why Not Graphical?

The system automatically opens the Query dialog box displaying a list where
the word office appears in the customer’s name, for example, Office Ware-
house Supply, Warehouse Office Supply, or Supply Warehouse Office. To re-
trieve a customer using more than one word, you could type OFFICE AND
LAW. The system retrieves each instance where the words office and law ap-
pear in a customer’s name.

While using word search, you can also use a boolean variable to retrieve cus-
tomers using more than one word. The words “or” and “and” are key words
that let you search for multiple words in the customer’s name. The word “or”
means that only one of the words has to exist in the description. The word
“and” means that both words must exist in the description.

Faxing and E-mailing
One button faxing and e-mailing is available from Order Entry and O/E His-
tory.

Catalog Explorer
The Catalog Explorer lets you select an item from the contents of various
wholesaler catalogs including S.P. Richards, United Stationers, and Tech Data.
You can use the Catalog Explorer to select an item in the Order Entry Item De-
tail tab, in the Item window (through the Item Query dialog box), and in the
Purchase Order Entry Item Detail tab. Catalog Explorer lets you find an item
without knowing the item number. You can view wholesaler catalogs by dif-
ferent levels: multi-level, single-level, and page or vendor.

Viewing Item Customer Sales History
You can easily view information on an item previously sold to the customer.
When you do, all the invoices on which this item was sold appear. This feature
also allows you to view line item detail for any one of the past invoices. In the
Item Detail tab, click the item on the order for which to view sales history.
Then just press F7 and the Customer Item History dialog box opens listing the
customer's account number and the information for the item you selected. The
invoices on which this item appears are also shown. The invoice number, in-
voice date, order quantity, cost, selling price, and gross profit percentage ap-
pear.

You can also quickly view manufacturer history in order entry. You can view
items that were sold to the customer by specifying the item's manufacturer
and/or description. This feature also lets you view specific information about
the sale of each item even if you don’t know the item number. In the Item De-
tail tab, press F10. You can enter the manufacturer name or search for the in-
formation.
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Changing Item Settings
Other former specials are also stored in two settings dialog boxes: the Order
Settings dialog box and the Item Settings dialog box, respectively. These dia-
log boxes display several former specials used in the text-based system. In the
Order Settings dialog box, you can make changes that affect the entire order.
However, these changes are in effect for this order only. Instead of using the
CONTRACTS, CTAX, DROPSHIP, WHOCALLED specials, boxes in the Order
Settings dialog box let you easily flag the order as a drop ship order, specify
who called to place the order, set the taxable status for the entire order, specify
contracts, and specify a secondary salesperson for commission purposes.

In the Item Settings dialog box, you can specify settings for specific line items.
To do this, the item must be shown in the first line on the order. If it appears
on a different line, double-click it to move it up to the first position. You can
specify a particular item as non-taxable, or change its tax district. You can
change the item’s commission code, and specify that the item not be included
when you run the automated short-buy.

Viewing O/E History & Reprinting
An advantage to using a graphical interface is the ease with which you can ac-
cess history information. You can view order and item sales history while:

• Placing Your Order

• Verifying Orders

• Changing Orders

• Creating Credit Returns.

This feature lets you access the O/E History window to view past orders. This
includes entries that are stored in the current sales journal, JOUR-S; the active
order entry file, P-MASTER; or renamed sales journals.

Another new feature is that you can print as many times as needed!
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Purchasing
In Purchase Order Entry, you can now run the short-buy report on screen. Cre-
ating a short-buy in graphical is easy and can be done in a minimal number of
windows with just a couple clicks of your mouse. See Figure 4. You can create
multiple short-buys quickly and save them for future use. Complete the infor-
mation then click the Save button. The short-buy is saved and can be retrieved
in a couple of clicks!

You can view a list of items by vendor or change the vendor with one simple
click. You can change cost on-line and use all the purchasing functions from
one window. You can modify the purchase orders both before and after you
send them to the vendor or wholesaler. First you set your limits, then view the
items this search retrieves and finally build the purchase order. You no longer
have to print the short-buy report to create a short-buy purchase order. Creat-
ing the short-buys in the appropriate window automatically builds the files.

Using the short-buy procedure, you can put items directly on a purchase order
from the file. This speeds up the process since you don't have to create a pur-
chase order by entering each item individually.

Figure 4: The
Short-Buy Setup

Window
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Changing Purchase Orders
There are several ways to change a purchase order. You can change:

• Received quantity

• Acknowledgement number (you can also mass change)

• Due date (you can also mass change)

• Cost and prices

• Item quanities and information.

You can easily change purchase orders in the Receive/Change tab. It’s easier
than ever to receive items and un-receive items. You can right-click the line
item and receive each line separately or you can unreceive the item by clicking
the red arrow or typing Ctrl + I.

Salespersons
There are new functions available in the Salesperson database. In the Salesper-
son Master tab, you can limit salespersons to only view their customers. Use
the drop down arrow in the User Type box to select Salesperson. When query-
ing customers, this salesperson only sees the customers assigned to his or her
salesperson number or salesperson alias.

Maintaining your salesperson database is now much easier. With one click,
you can limit your salesperson to only have access to view database screens or
to only have the ability to process orders in order entry.

Note: To restrict this salesperson to only viewing his or her customers, you
must also set the Restrict Salesperson Access to their Customers Only
parameter in the (LHY) Salesperson Parameters screen to Y. After set-
ting this parameter, ECi recommends that you rebuild the customer in-
dex files.

Customer Price Plans
Customer Price Plans allows you to set up price plans for customers. After you
add your items, you can place special pricing, or a discount, on an item or
group of items. You can assign price plans to customers or customers to price
plans.

Note: Assigning customers to price plans is an authorized feature. It may not
be included in your software package. For more information, contact
ECi sales.



18

Why Not Graphical?

Item Groups price plan is a new price plan that lets you add special groups to
a specialty price plan. You can place special pricing on an item or group of
items. You can specify a gross profit percentage or discount percentage for the
groups of items. Setting this up does not set the price, just the percentage. Item
Groups price plan saves only the items and the percent on the price plan. This
means no refiguring if the item's price changes — the system automatically
uses the current cost or price from the item database.

Specialty contracts begin with one of five symbols (%, !, $, #, or " followed by a
number or a letter), for example, %1. The symbol is the first character in the
contract number and determines which items are included in the contract, as
follows:

• % = Special pricing on every item

• ! = Special pricing on all items with specified assortment codes

• $ = Special pricing on all items within specified departments

• # = Special pricing on all items with specified stock classes

• " = Special pricing on all items with specified SIC codes.

When creating a price plan, selecting a specialty price plan just takes one click
on the arrow in the Specialty Price Plan box. The different types of specialty
price plans are shown in Figure 5.

Figure 5:
Specialty Price

Plans
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Figure 6:  The
Financial

Reports
Window

General Ledger
Creating custom financial reports is easier and faster than ever. Previously, in
text-based software, you had to build financial tables before you could run re-
ports. No more! You can create financial reports without building financial
tables! The Financial Reports window lets you create customized financial
statements  simply by categorizing general ledger account numbers. You can
view the reports on screen before printing or you can export the reports to an
Excel spreadsheet or text file. You can also save your custom reports and they
are automatically added to your list of reports.

In the Financial Reports window, there are currently two reports available:
Balance Sheet and Profit and Loss. See Figure 6. A balance sheet shows your
net worth at a glance, including what you have and what you owe. Periodi-
cally running a balance sheet lets you see how your business is doing. The
profit and loss statement provides a snapshot of how your business is doing
for the specified period. The profit and loss statement includes sales, cost of
goods, and expenses.
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Code Text Screen Title Accessing the Graphical Equivalent

* Editor Text Based Only
! Word Processor Text Based Only
+ Specials Keyop Menu Icon >  Specials icon (text based)
? Planner Text Based Only
@ Printer Setup Text Based Only
& Faxing Program Faxing Icon
“ Contact Fax & E-Mail Customer Icon > View Menu > (Customers)
“ Contact Fax & E-Mail Salesperson Icon > View Menu > (Salesperson)
“ Contact Fax & E-Mail Vendor Icon > View Menu > (Vendors)
A Customer Master (main) Customer Icon > Master Tab

Customer Master (credit Customer Icon > Credit Tab
A limit & start limit)

Customer Master Customer Icon > Shipto/Attention Tab
A (shipping address)

Customer Monthly Customer Icon > View Menu > History > Monthly
AB Budgets Budgets Tab
AF Customer Credit Cards Customer Icon > View Menu > Credit Card
AG Customer Auto Billing Customer Icon > View Menu > Auto Bill

Customer History Customer Icon > Credit Tab
AH (A/R Information)

Customer History (MTD Customer Icon > View > History > Total Sales Tab
AH & YTD Sales)
AL Customer Buyers List Customer Icon > Buyers/Manifest Tab

Customer Service Quality Customer Icon > View Menu > History> Service
AQ Quality Tab
AQ Shipping Manifest Customer Icon > Buyers/Manifest Tab
AQ Summary Billing Customer Icon > Credit Tab
AQ E-Mail Category, Region, Customer Icon > Master Tab

& Area
AQ Exp. Sales $, of Emp. #, Customer Icon > View Menu> History > Total Sales

Exp. Margin $, Exp. G.P.% Tab
AR Customer Master Reindex Text Based Only
AS Customer Sales History Customer Icon > View Menu > History > Group Sales Tab
AT Tax Districts Tables Customer Icon > View Menu > Tax District

Customer Attentions Customer Icon > Shipto/Attention Tab
AX Cross Reference

(Attention & Shipto)
AX Customer Attentions Customer Icon > View Menu > Credit Cards

Cross Reference (Credit
Cards)

B Accounts Receivable Accounts Receivable Icon
Posting

BA Bad Account Number File Text Based Only
BB Batch Accounts Receivable Icon > Batch Totals
BC A/R Posting Change Accounts Receivable Icon > Post/Change Tab
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Why Not Graphical?

Code Text Screen Title Accessing the Graphical Equivalent

BE A/R E-Mail Statements A/R History Icon > Retrieve Customer > File > EMail
BF A/R Fax Statements A/R History Icon > Retrieve Customer > File > Fax
BI A/R Inquiry A/R History Icon
BO A/R Inquiry by PO # Accounts Receivable Icon > Post Change Tab
BP A/R Posting Accounts Receivable Icon > Post Change Tab
BQ A/R Check Posting Accounts Recievable Icon > Payments Tab
C Vendor Master Vendor Icon > Master/RemitTo/Account Status Tabs
CE Vendor EDI Parameters Text Based Only
CP Vendor Electronic Invoicing Vendor Icon > View Menu > Electronic Invoicing
CR Vendor Re-Indexing Text Based Only
CS Vendor PSN Vendor Icon > View Menu > Supply Options
CV Vendor Alias Vendor Icon > View Menu > Vendor Alias
CX Vendor Private Comm- Vendor Icon > View Menu > PCN

unication Network
DA Accounts Payable Accounts Payable Icon > AP Invoice Tab
DB A/P Auto Pay Text Based Only
DD A/P Discount Accounts Payable Icon > AP Invoice Tab > Retrieve

Invoice and Change Disc % > Post
DE Checks File Accounts Payable Icon > Action Menu >

Post to Check File
DI Accounts Payable Inquiry Accounts Payable History Icon
DM Accounts Payable Mark Accounts Payable Icon > Payments Tab > Setting

Invoices to Be Paid Limits
DO Accounts Payable Post P/O Accounts Payable Icon > Post P/O Tab
DP Accounts Payable Pay Accounts Payable Icon > Payments Tab > Handcheck

(Handcheck)
DT A/P Batch Totals Accounts Payable Icon > Batch Totals Tab
DV A/P Void Check Accounts Payable Icon > Action Menu > Void
E Inventory Master Item Icon > Master or Settings Tabs

(Master Record & Pricing
Record Fields)

E Inventory Master (Direct Item Icon > Vendors or Master Tab
Buy, Primary Wholesaler,
Purchasing Vendor)

E Inventory Master (Usage Item Icon > View Menu > History > Inventory Tab
Record)

E Inventory Master Item Icon > Settings Tab
(Mult Units of Measure)

EB Bill of Materials Link Item Icon > View Menu > Bill of Materials (text based)
EG Multiple Bins Item Icon > View Menu > Item Bins
EH Inventory History Item Icon > View Menu > History > History Tab
EK Bulk Item Update Screen Text Based Only
EL Customer Item Price Check Text Based Only
EN Inventory Remarks Item Icon > Remarks Tab
ER Inventory Re-Index Text Based Only
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Code Text Screen Title Accessing the Graphical Equivalent

ES Inventory Alias Item Databases > Item Alias
ET Inventory Contract Price Item Icon > View Menu > Inventory Contract (text based)
EV Vendor Contracts Item Icon > View Menu > Vendor Contracts (text based)
EX Item SIC Extended Desc Text Based Only
EZ Serialized Inventory Serialized Icon (text based)
E+/SPE Special Item Screen Keyop Menu Icon > Specials Icon > E (text based)
FC Purchase Order Change Purchase Order Entry Icon > Change Action Code
FD Purchase Order Delete Purchase Order Entry Icon > Delete Action Code
FE E-Mail Purchase Order P/O History Icon > Email P/O Icon
FF Fax Purchase Order P/O History Icon > Fax P/O Icon
FI P/O Inquiry P/O History Icon
FM Debit Memo Text Based Only
FO Purchase Order Entry Purchase Order Entry Icon > Order Action Code
FP Print Purchase Order P/O History Icon > Print Icon
FR Receive P/O Purchase Order Entry Icon > Pre-Receive or

(Pre-Receive & Final) Final ReceiveAction Code
FS Purchase Order Short Buy Purchase Order Entry Icon > Short-Buy Action Code
FT Purchase Order Transfer Purchase Order Entry Icon > Transfer Action Code
GA Order Entry (Auto Bill) Order Entry Icon > Auto Bill Action Code
GC Order Entry Change Order Entry Icon > Change Action Code
GD Order Entry Delete Order Entry Icon > Delete Action Code
GE EDI Release Text Based Only
GF Order Entry Fax O/E History Icon > Retrieve Invoice > File > Fax
GG Order Entry E-Mail O/E History Icon > Retrieve Invoice > File > Email
GI Order Entry Inquire O/E History Icon
GJ Journal Functions Text Based Only
GL Customer Price Check Text Based Only
GM Modify Quotes Order Entry Icon > Change Action Code
GO Order Entry (commercial) Order Entry Icon
GP Order Entry (retail) Order Entry Icon > Order Style > Retail
GQ Quotes Order Entry Icon > Pay Code > Quote
GR Order Entry Release Order Entry Icon > Release Action Code
GS Drop Ship Order Entry Text Based Only
GU Furniture Order Entry Order Entry Icon > Order Style > Furniture
GUT Furniture Project Furniture Project Management Icon

Management
GV Order Entry Verification Order Entry Icon > Initial or Final Verify Action Code
GX Credit Returns Order Entry Icon > Credit Action Code
HY Salesperson Master Salesperson Icon
HYF Salesperson Allowable Salesperson Icon > View Menu > Functions

Functions
HYL Salesperson Price Check Salesperson Icon > Price Check Tab

Parameters
HYP Remote Order Entry Salesperson Icon > Remote Order Tab

Parameters
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Code Text Screen Title Accessing the Graphical Equivalent

HYP1 Remote Order Entry Salesperson Icon > Addl./WinOrder Tab
Parameters

HYR Salesperson Re-Index Text Based Only
HN Personnel Master Personnel Icon (text based)
I Payroll Update Personnel Icon (text based)
J Chart of Accounts Master General Ledger Icon > Chart of Accounts Icon
K General Ledger Posting General Ledger Icon > GL Posting Icon
L Parameters Keyop Menu Icon > Parameters Icon (text based)
M Operational Procedures Keyop Menu Icon > Operational Procedures Icon

(text based)
N Custom Customer Reports Reports Menu Icon > Custom Customer (text based)
NR Standard Customer Reports Reports Menu Icon > Standard Customer (text based)
O Custom A/R Reports Reports Menu Icon > Custom A/R (text based)
OR Standard A/R Reports Reports Menu Icon > Standard A/R (text based)
P Custom Vendor Reports Reports Menu Icon > Custom Vendor (text based)
PR Standard Vendor Reports Reports Menu Icon > Standard Vendor (text based)
PD President’s Screen General Ledger Icon > President’s Screen Icon (text

based)
Q Custom A/P Reports Reports Menu Icon > Custom A/P (text based)
QR Standard A/P Reports Reports Menu Icon > Standard A/P (text based)
R Custom Inventory Reports Reports Menu Icon > Custom Inventory (text based)
RR Standard Inventory Reports Reports Menu Icon > Standard Inventory (text based)
S Custom P/O Reports Reports Menu Icon > Custom P/O (text based)
SG EDI Communication Text Based Only
SM Distribution Specialist Text Based Only

Custom Platform
SR Standard P/O Reports Reports Menu Icon > Standard P/O (text based)
T Custom O/E Reports Reports Menu Icon > Custom O/E (text based)
TD Print Shipping Labels Text Based Only
TM Picking Manifest Warehouse Icon > Picking Manifest Icon (text based)
TR Standard O/E Reports Reports Menu Icon > Standard O/E (text based)
TS Shiping Manifest Warehouse Icon > Shipping Manifest Icon (text based)
U Custom Sales Reports Reports Menu Icon > Custom Sales (text based)
UR Standard Sales Reports Reports Menu Icon > Stadard Sales (text based)
V Personnel/Payroll Reports Menu Icon > Personnel Reports (text based)
W General Ledger Reports Reports Menu Icon > G/L Reports (text based)
X Program Security Keyop Menu Icon > Program Security Icon (text based)
Z System Utilities Keyop Menu Icon > System Utilities Icon (text based)
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